Accessing Oracle 11g from Microsoft SSIS Using
DataDirect Connect for ADO.NET

This article explains how easy it is to connect to an Oracle 11g server from Microsoft SQL
Server 2008 Integration Services (SSIS) by using the DataDirect Connect for ADO.NET data
provider.
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Choosing the Right Oracle Data Provider for SSIS

SSIS provides a solid foundation for constructing enterprise-level data integration and
transformation solutions. It can interact with data in a wide variety of formats and layouts.
SSIS offers a rich graphical user interface, which often eliminates the need to write copious
application logic. In fact, many integration projects can be performed without writing a single
line of code.

DataDirect’s 100% managed code architecture makes it an ideal data provider to use with
SSIS packages, which run as managed code. This means there’s no need to install,
configure, or maintain any additional client-side software such as Oracle’s client libraries. All
interaction with the database is handled within the CLR (Common Language Runtime),
leading to better performance, security, and reliability as shown below.
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Installing DataDirect Connect for ADO.NET and Testing Connectivity

In this simple example, we’ll show how to extract information from the EMP table in the
‘SCOTT schema in an Oracle database, and write it into a text file. To keep things simple,
we’'ll use Oracle’s basic scott/tiger login even though DataDirect Connect for ADO.NET SUpports
more sophisticated security technologies such as Kerberos and NTLM. In addition, we'll use
only the most basic SSIS workflow capabilities.

1.

Install DataDirect Connect for ADO.NET
Note: This article was written using version 3.2. If you are using a newer version, you
can follow these same steps as well.

Make sure you have administrative privileges on this computer. In addition, before
installing the DataDirect product, make sure you’re running one of the following
operating systems:

Windows Server 2008 (all Editions)

Windows Vista (all Editions)

Windows XP Home Edition and Professional
Windows Server 2003 (all Editions)

e Windows 2000

DataDirect Connect for ADO.NET supports the 32- and 64-bit versions of these
operating systems.

If you install DataDirect Connect for ADO.NET before SQL Server and/or Visual Studio,
you'll also need to run the Visual Studio Provider Integration Tool, located on the
DataDirect Connect for ADO.NET menu. This utility updates registry and other settings
to enable Visual Studio to take full advantage of DataDirect Connect for ADO.NET'S
capabilities.

Launch Visual Studio. This is where you create and manage SSIS projects.

Test connectivity to Oracle by creating a connection and then retrieving data:
a. Make sure the Server Explorer is visible (View -> Server Explorer)
b. Onthe Tools menu, choose the Connect to Database option.
c. Fill in details about your Oracle connection. Make sure to select the
DataDirect Connect for ADO.NET Oracle Data Provider.
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Enter information ko connect to the selected data
source or click "Change” to choose a different data

source andfor provider.

Data source:

[Databirect Technologies (DDTek.Oracdl  Change... | N
~ Connect to Oracle 1

¥ Standard Connection

SID: !— o e Te Description
. Name: e b &2 prvwdg&fw Fast, Imwseqn
. Microsoft ODBC Data Source 4 T
= Microsoft SQL Server access to ol versions of Oracle
NSMames Connection Microsoft SOL Server Database File (Oracle 8, 9, 109 and 11g).
£i = [Oracle Database

Server Name: ] - I

Login information Data provider:

C Use Kerk henticati IMED_"M Connect for ADONET Orz =

% Use Oracle Authentication

© Use Client Authentication
" Use Kerberos & Orade Authentication
User ID:  |scott

Passward: i"m—
¥ [Save my password

Test Connection | o | cancel |

A

Note that one of the benefits of DataDirect Connect for ADO.NET is that there’s no need to
install a tnsnames.ora file on the client.

4. Once you've finished entering your connection details, click on the Test Connection
button to make sure that everything works. After you receive a message that a
connection has been established, click OK to save the connection.

5. Expand the Tables entry of your new connection. Right click on the EMP table, and
choose the Retrieve Data option. This should bring back a number of rows from this
table. You have many other options here as well; simply right-click on any database
object to get a full list.

O EMP: Query - Microsoft Visual Studio _ @ x|

File Edit View Data QueryDesigner Tools  Window  Help

T I IR = [ Y =R

BEREEFET g il [S]) change ype~ | ¥ Fb | (2 | 19 04 ¢
Server Explore NS Ep: query | - »x EE

EMPNO ENAME o8 MGR | HIREDATE =)
=l [ Data Cannections » s SMITH CLERK 790z 12117199
- [ ASPEN.ORCL.SCOTT —
3 Tables 7499 ALLEN SALESMAN 7658 2fz0]1951
7 [ BoNUS 7521 WARD SALESMAN 7698 2/z2/1981
¢ [ cerr 7566 IOMES MANAGER 7839 4f2/1981
- [ e —
= 3 eveno 76854 MARTIN SALESMAN 7658 9fza{1981
=] Enave 7698 BLAKE MANAGER 7639 5/1/1981
[ 108 7782 CLARK MAHAGER 7839 6031951
. % zlcvinme 7788 SCOTT ANALYST 7566 4/19/1967
- s 7839 KING PRESIDENT L 11j17/198
[ corm 7844 TURNER. SALESMAN 7698 9/8/1981
Bl ceptio 7876 ADAMS CLERK 7788 5/23/1967
h PK_EMP ——
o TEw.2 7300 IAMES CLERK 7698 1243/1981
. [ SALGRADE 7902 FORD ANALYST 7566 1243/1981
(3 vews 7934 MILLER. CLERK 7782 1231962
(3 Synonyms —
£3 Sequences [ AL o i AL
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- [ Functions
[ Package Pracedures
[ Package Functions
Al I =)
i Server Explorer [ Toobox 4 4 |t of14 [ b Bl B

Ready
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Configuring for Optimal Performance

Coming up with optimal configuration settings for connecting to a powerful database such as
Oracle can be daunting. To make things easier, DataDirect Connect for ADO.NET offers a
helpful Performance Tuning Wizard.

1. To access the Wizard, select the Tools -> DataDirect Technologies -> Run
DataDirect Performance Tuning Wizard menu option.

This launches the wizard, which will ask a series of more than two dozen
performance-related questions, two of which are shown below.

.DataDirect Performance Tuning Wizard

DataDirect Performance Tuning Wizard —
Select Statements a

N o

How mary rows are bypically returned when executing Select statements?

1
210
1150
 51-200
& Over 200

— Details

The data provider can limit the number of butes of data to prefetch to the client when executing a statement that
produces a result zet. This option can limit the actual connection to one active staternent if itz value is not large
enough ko hold the entire result get. Lsing a vemw large number can have a negative effect on performance.

.DataDirect Performance Tuning Wizard

wa

DataDirect Performance Tuning Wizard —
Semver-Side ResultSet Caching a
‘ I:w ADO AT

Does your application connect to Oracle 117

" Yes
i* Mo

r— Details

If your application connects to Oracle 11g and executes the same query multiple times, you can improve perfomance
by using the Oracle server-side resultset caching feature. When enabled, Oracle stores the result set in database
memory, On subsequent executions of the same query, the result set is retumed from database memany i the
underlyitg table: have not been modified. Without result zet caching, the server would process the queny and
formulate a new result set,
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Once you reach final page of the wizard, DataDirect Connect for ADO.NET will
generate the ideal configuration based on the answers you gave as shown below.

.DataDirett Performance Tuning Wizard x|

DataDirect Performance Tuning Wizard —_—
Result 3
\__'_._w.':o-‘:;

The Performance Tuning ‘wizard has generated the optimal connection canfiguration based on your answers. Choose
from the following options to apply the new connection string options.

{* Copy the connection sting to clipboard
" Create a new connection with the Performance Tuning ‘Wizard connection string options

" Generate a new application pre-configured with these connection setlings

€ Wsing ADOMET 1.0 pravider-specific interfaces
& [sing AD0.HET 2.0 common programming interfaces

Froject Location | Browse... |

Project Type @ ot
€ Yisual Basic

— Connection String
Statement Cache Mode=tuta Server Type=:Load Balance Timeout=0;Max Statement Cache Size=10ire Pratocal
Mode=1.Enlist=Falze B atch Update Behavior=AnayBindOnlyinserts; Pooling=T rue Session Data Unit=8192:Cursor
Description Cache=T e Max Pool Size=100;Connection Reset=F alse;Fetch Array Size=128000;

Set the value of the UpdateB atchSize property for the OracleD atafdapter ta 0.

Cancel | < Back | Finizh I

Creating an SSIS Project and Connecting to Oracle

1.

2
3.
4

Create a new project, using the Integration Services Project template.
Make sure the Solution Explorer is visible (View -> Solution Explorer)
Right-click on Data Sources and choose the New Data Source option.
Click the New button in the Data Source Wizard, then select the Data Direct Oracle
Data Provider from the .Net Providers folder as shown below.
=T -
Select how to define the connection Provider: [ Native OLE DB\SQL Server Native Client 10.0 =l
vou(an_sele:i_FrqmanumbewfWavsin which your data source will define its 5 I et Providers —
connection string, ,a! 4 SqiClient Data Provider -
- 4 OracleChient Dats Provider
% Create a data source based on an existing or new connection Corecthy
Dokapocmecions: Dotsicanection propesties: _,_jr 4 Microsoft SQL Server Compact Data Provider -
Property | Vale 00000 Al L Microsoft SQU Server Compact Edtion Client Data Provider

[# [24 /Nt Providers for OleDb
) |2 Mative OLE DB
A Microsoft Jet 4.0 OLE D8 Provider
a L Microsoft OLE DB Provider for Analysis Services 10.0 =

€ Create a data source based on another cbject

M A vald connection must be selected. [

< Back Hexs (L) Canxel I/ Test Connection [ ]| conm Heb

DATADIRECT TECHNOLOGIES 5 oF 9



10.
11.

12.

13.
14.

Fill in the details about your connection, just as you did when testing the connection
in a previous step. Test the connection to make sure your settings were entered
correctly.

Provide a meaningful name for your connection, and finish the Data Source Wizard.
Click on the Control Flow tab.

Right click in the Connection Managers section of the screen, and choose the New
Connection for Data Source... option.

Select the connection you created in step 5 above.
Switch to the Data Flow tab, and click on the link in the middle of the screen.

Click on the ADO NET Source from the Data Flow Sources section of the toolbox,
and drag it into the middle of the screen.

Double-click on the ADO NET source. This brings up a dialog box where we’ll select
the EMP table from Oracle.

Select the connection manager you created earlier.

Choose the Table or View data access mode, and select the “SCOTT”.” EMP”
entry. Depending on whether you saved your security settings earlier, this may
require a fresh login to the Oracle database.

. ADO.NET Source Editor 10l x|

Configure the properties used by a data flow to obtain data from any ADC.MET provider,

Connection Manager Specity an ADO.MET connection manager, a data source, or a data source view, and select the data
access mode, After selecting the data access mode, select from among the additional data access

Columns options that appear.

Error Cukpuk

ADC,MET connection manager:

| oRACLE on AsPEn ~| New .,

Data access mode:

ITabIe oF Wi j

Mame of the table or the view:

2 "sCoTTEMP -

2 "PM"."ONLINE_MEDIA" =

= PM"PRINT_MEDIA"

=

=

= ==

[]

= sCOTT'."EMP_2"

2 "sCoTT"."SALGRADE" -
<| |ﬂ Preview. ..

OF I Cancel Help
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15. Once you've connected to the database, click Preview to get a sneak peek at your
data.

16. Click OK to finish saving your preferred table settings.

Extracting Data into a Text File

1. Click on the Flat File Destination from the Data Flow Destinations section of the
toolbox, and drag it into the middle of the screen.

2. Click on the ADO NET Source graphic, and drag a green line to the Flat File
Destination. This connects Oracle with the flat file.

3. Double-click on the Flat File Destination and configure your desired output settings,
including file name, directory, and column mappings.

_El_FIat File Connection Manager Editor ;Iﬂlﬂ
Conneckion manager pame: |F|at File Connection Manager
Description: IOutput file For this example

1 General Select a file and specify the file properties and the file format.
Columns
Advanced

= Preview File name: Ic:'l,output.txt Browse. .. |

Locale: IW ™ Unicode

Code page; |1252 (AMSI - Latin I) j
Farmat: IDeIimited j

Text gualifier: |<n0ne>

Header row delimiter: |{CRHLF} j

Header rows to skip: In ﬁ

¥ Colurnn names in the first data raw

OF I Cancel | Help |

4. You can now test your project by clicking on the green Start Debugging icon at the
top of the screen. If everything is configured correctly, you should receive a message
stating that the project ran successfully as shown below.

A
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ﬁlntegration Services Project 10 (Running) - Microsoft ¥isual Studio

File Edit ‘iew Project Build Debug Data Format  SSIS  Tools  Window  Help

2 - Ha| %R 9™ | |Development: - ':\:‘41 el i 5 P om
EEX I
' Package.dtsx [Design]
3% Cantral Flaw Data Flow | %] Event Handlers Ta Package Explorer | %+ Progress
o a
Data Flow Task: If'_,;‘ Diata Flow Task

14 rows

1,1 Connection Managers

J ORACLE on ASPEN
jl_FIat File Connection Manager

@Packa e execution completed. Click here bo switch to design mode, or select Stop Debugaing From the Debug menu.

You should also now have a text file containing Oracle data as shown below.

E'. output - Notepad

File Edit Format Yew Help

EMPNO, ENAME, JOE, MGR, HLREDATE, SAL , COMM, DEPTHO
7360, SMITH, CLERK, 7902,1980-12-17 Q0:00:00, 800,00, ,20

7499, ALLEN, SALESMAN, 7698, 1581-02-20 00:00:00,1600.00,300. 00, 30
7521, WARD, SALESMAN, 7698, 1981-02-22 00:00:00,1250.00, 500. 00, 30
7566, JONES, MANAGER, 7839, 1081-04-02 00:00:00,2975.00,,20

7654, MARTIN, SALESMAN, 7EGS, 1951-00-28 00:00:00,1250.00,1400. 00, 30
7698, BLAKE, MANAGER, 7539, 1581-05-01 00:00:00,2850.00,,30

7782, CLARK, MANAGER, 7839, 1581-06-00 00:00:00,2450.00,,10

7788, SCOTT, ANALYST, 7566, 1987-04-19 00:00:00, 2000, 00, , 20

7839, KING, PRESIDENT, ,1981-11-17 00:00:00, 5000.00,,10

7844, TURNER, SALESMAN, 7695, 1981-09-08 00:00:00,1500.00,.00,30
7876, ADAMS, CLERK, 77588, 1987-05-23 00:00:00,1100.00,,20

7900, JAMES, CLERK, 7698,19581-12-03 (Q0:00:00, 950,00, , 30

7902, FORD, ANALYST, 7566, 1981-12-03 00:00:00,3000.00,,20

7934 ,MILLER,CLERK, 77582,1082-01-23 00:00:00,13200.00,,10

Ready to try DataDirect Connect for ADO.NET with SSIS? Download a trial today or call
1-800-876-3101 to speak with an account executive.
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FOR MORE INFORMATION

800-876-3101

DataDirect

DataDirect Technologies is the software industry's only

Worldwide Sales comprehensive provider of software for connecting the world’s
Belgium (Frenchy.............. 0800 12 045 most critical business applications to data and services, running
Belgium (Dutch)..... ---.0800 12 046 on any platform, using proven and emerging standards.
France................. ..0800 911 454 . X
Germany .. 0800 18178 76 Developers worldwide depend on DataDirect® products to

JAPAN ..o 0120.20.9613 connect their applications to an unparalleled range of data

Netherlands........... ....0800 022 0524 : .
United Kingdom .......0800 169 19 07 sources using standards-based interfaces such as ODBC,
United States...........o...... 800 876 3101 JDBC™ and ADO.NET, XQuery and SOAP. More than 300

leading independent software vendors and thousands of
enterprises rely on DataDirect Technologies to simplify and
streamline data connectivity for distributed systems and to

_ _ reduce the complexity of mainframe integration. DataDirect
© 2009 Progress Software Corporation. All rights reserved.

DataDirect is a registered trademark of Progress Software Technologies is an operating company of Progress Software
Corporation. Other company or product names mentioned B
herein may be trademarks or registered trademarks of their Corporat|on (Nasdaq: PRGS)

respective companies.
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